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1. Introduction 

Welcome 

Bell Ringing Manager is a Windows application designed to schedule and trigger network-controlled 
bells, sirens and relays. It is commonly used in schools, factories, sports facilities and any environment 
where audible signals must be played at precise times throughout the week. 

The application is built around four core ideas: 

• A weekly schedule of bell events grouped by day of the week. 

• A list of network devices (relays and bridges) that produce the actual sound or trigger external 
equipment. 

• A licensing system that enables full operation on each PC. 

• An optional Windows service that runs the schedule in the background even when no user is 
logged in. 

Key features 

• Multiple parallel schedules (regular schedule, exam weeks, summer programs, etc.) with 
start/end dates. 

• Support for Generic TCP devices, Symcod Bridge-IP, and Waveshare 8-relay Modbus modules. 

• Non-blocking network operations: a non-responding device never freezes the application. 

• Test mode with visual progress indicator (3-second timeout per device). 

• Multi-language interface (English, French, Spanish) - switchable at any time. 

• Live license-status indicator at the right of the menu bar (a colored LED next to the wording). 

• Dedicated Activity log page with Copy / Save to file / Clear actions. 

• Backup of configuration and licenses to a single ZIP archive. 

• Import of legacy Symcod configuration files (CLOCHE.* format). 

• Windows service option for fully unattended 24/7 operation. 

System requirements 

• Windows 10 or Windows 11 (64-bit). 

• Network connectivity to the controlled bell devices. 

• Administrator rights required only for service installation/management. 

• A valid license code for each PC that will run the application. 
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2. Main window overview 

The application opens on the Schedule page by default. The window is divided into two main areas: a 
sidebar on the left and a content panel on the right. 

 

Figure 1 - Main window showing the Schedule page. 

The sidebar 

On the left side of the window you will find: 

• The product logo and name (Bell Ringing Manager). 

• The navigation menu with five sections: Schedule, Devices, Activity log, Licenses, Service. 

• The current version number at the bottom (e.g. v.2026.05.28.17). 

Click any section to switch the right-hand panel to that page. 

Navigation alerts 

Some menu items can display a pulsing warning icon to indicate that your attention is needed: 

• Licenses entry pulses if no valid license is active or the trial period is about to expire. 

• Service entry pulses if the Windows Service is not installed or not running. 

The menu bar 

The top menu bar contains four menus plus a permanent license indicator on the right: 
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Field Description 

File Import / export schedules from CSV or XLS files; Exit. 

Tools Copy a day across schedules, copy an entire schedule, import legacy 
Symcod configuration, install / uninstall the Windows Service. 

Language Switch between English, French and Spanish (applies instantly). 

Help Open the Licenses page directly, view the About dialog with version 
and copyright information. 

License indicator Always visible at the right edge of the menu bar. A colored dot (LED) 
plus a "License: ..." text shows the current entitlement state. The text 
matches exactly the banner on the Licenses page. 

NOTE: The license LED color follows the state: green = active, light green = expiring with a future 
renewal, amber = expiring soon, red = expired or blocked, gray = 15-minute trial mode. 
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3. Schedule page 

The Schedule page is where you define when each bell rings throughout the week. It supports multiple 
parallel schedules, so you can keep your regular weekly bells separate from special events like exams or 
summer hours. 

 

Figure 2 - Schedule page with the default schedule loaded. 

Page title 

At the top of the page the large "Schedule" title is followed by a short description in parentheses ("Bells 
scheduled for each day of the week"). The title appears in all five sidebar pages with a similar inline 
description. 

Next bell banner 

Just below the title, a banner shows the next scheduled bell along with a live countdown. It updates 
every second. 

• Bell icon on the left. 

• Day of week, time, description and device id of the upcoming bell. 

• Countdown text (e.g. "in 2d 14h 51m 25s"). 

• TEST NOW button on the right: immediately fires the next scheduled bell (useful for verifying 
without waiting). 
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NOTE: If no event is scheduled, the banner displays "No upcoming bell scheduled" with a silent bell 
icon. 

Schedule selector 

Below the banner is the schedule picker row. It lets you switch between schedules and manage them. 

• Schedule dropdown - lists all available schedules with their ID and description. 

• Status indicator - shown next to the dropdown in brackets: 

◦ [ Active ] - this schedule always fires. 

◦ [ Inactive ] - this schedule is paused (events stored but never fire). 

◦ [ Period 2026-09-01 -> 2026-12-20 ] - this schedule fires only between the dates shown 
(green if active today, gray otherwise). 

• Add / Edit / Delete buttons - create, modify or remove a schedule. 

WARNING: The default schedule (ID 1) cannot be deleted. Its name and status can be edited, but it 
must always exist. 

Day-of-week tabs 

Under the schedule picker, seven tabs (Sunday through Saturday) let you view and edit the events for 
each day. The currently displayed tab corresponds to the events listed in the table below it. 

Events table 

Each row represents one bell event scheduled on the selected day. Columns are: 

Field Description 

Time The exact moment the bell rings, in HH:MM:SS format. 

Description A free-text label up to 50 characters (e.g. "5-min warning bell - first 
shift"). 

Device The device ID and description that will produce the bell. 

Duration How long the bell rings, in seconds. Default is 3 seconds. 

Bell # Bell number for multi-bell devices (Symcod relay 1 or 2, Waveshare 
relay 1 to 8). Use 1 if the device has a single output. 

Under the table are three action buttons: 

• Add - opens the Bell Event dialog to create a new event. 

• Edit - modifies the selected event. With multiple rows selected, edits the first one. 

• Remove - deletes the selected event(s). Multi-selection is supported (Ctrl+click, Shift+click). 

NOTE: Double-clicking a row also opens it in Edit mode. 



Bell Ringing Manager - User Manual 

Page 9 / 27 

Adding a bell event 

Click the Add button below the events table. The Bell Event dialog opens: 

 

Figure 3 - Bell Event dialog (add mode). 

Field Description 

Time (HH:MM:SS) Hour, minute, second using either direct typing or the - / + buttons 
under each field. 

Description Optional text (up to 50 characters). Helpful when reviewing the 
schedule later. 

Device Pick from the dropdown list of configured devices. 

Duration (s) Duration in seconds. Default is 3. 

Bell number Bell number, default 1. 

Click Add to save and add the event to the current schedule, or Cancel to discard. 
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4. Managing schedules 

You can create as many schedules as you need. The application supports the following statuses: 

Field Description 

Active Always firing. Use for your normal weekly schedule. 

Inactive Never firing. Use to pause a schedule without losing its events. 

Period Fires only between a start date and an end date (inclusive). Use for 
exam weeks, summer programs, special events. 

NOTE: Multiple active schedules can run in parallel. If the same time, device and bell number 
appears in more than one active schedule, the application fires only ONE bell to avoid duplicates. 

Add a new schedule 

Click the Add button next to the schedule dropdown. The Add schedule dialog opens: 

 

Figure 4 - Add schedule dialog with Active status. 

Field Description 

ID Read-only. Automatically assigned (always greater than 1 for new 
schedules). 

Description A descriptive name (up to 50 characters). 

Status Active, Inactive or Period. 

Start date Only when status is Period. The first day the schedule fires. 

End date Only when status is Period. The last day the schedule fires (inclusive). 
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When you choose the Period status, two date fields appear with a small calendar icon for date picking. 
The schedule will only fire bells on days that fall within the Start date and End date (inclusive). 

Edit a schedule 

Select the schedule in the dropdown, then click Edit. The dialog opens with the current values pre-filled. 
You can change the description, status and dates - the schedule's events are untouched. 

Delete a schedule 

Select the schedule, then click Delete. A confirmation dialog appears showing the number of events the 
schedule contains. Confirming permanently removes the schedule and all its events. 

WARNING: Deleting a schedule cannot be undone. If you only want to pause it temporarily, change 
its status to Inactive instead. 

Copy a day between schedules 

From the Tools menu, choose Copy day... to clone events from one day to another - across schedules if 
needed. The dialog has two sections: 

• Source - pick the source schedule and the day to copy from. 

• Destination - pick the destination schedule and check one or more days to receive the copy. 

NOTE: Events on the selected destination day(s) are replaced. If source and destination are the 
same schedule, the source day is automatically grayed out in the destination list. 

Copy a whole schedule 

From the Tools menu, choose Copy schedule to another... to replace the events of one schedule with a 
copy from another. The destination schedule's description, status and dates are preserved - only the 
events are replaced. 

This is useful for example to base an "Exam week" schedule on the regular schedule and then make a 
few adjustments. 
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5. Devices page 

The Devices page lists the network-connected hardware that produces the actual bell sound. Every 
event you create on the Schedule page references one of these devices. 

 

Figure 5 - Devices page. 

Devices table 

Field Description 

ID A short identifier you assign (typically 4 characters, e.g. 0001, BLDG-
A). 

Description A human-readable label shown alongside the ID throughout the app 
(up to 50 characters). 

Mode Client (this app initiates the TCP connection to the device) or Host (the 
device connects to this app - rarely used). 

IP Address The device's IP on your local network (Client mode only). 

Port TCP port (e.g. 1024 for Symcod Bridge-IP, manufacturer-specific for 
others). 

Command For Generic devices, the raw hex command sent on the wire (e.g. FF 
01 02). For Symcod and Waveshare devices, this column shows the 
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Field Description 

device type name - the command is auto-generated from the event's 
bell number and duration. 

Action buttons 

Below the table: 

• Add - create a new device. 

• Edit - modify the selected device. With multiple rows selected, edits the first one. 

• Remove - delete the selected device(s). Multi-selection supported. 

• TEST NOW - fire the selected device immediately (uses bell number 1 and a short duration). Use 
this for quick verification of an already-saved device. 

Adding a device 

Click Add to create a new device. The Device dialog opens: 
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Figure 6 - Device dialog (Waveshare type). 

Field Description 

Type Generic (custom hex command), Symcod Bridge-IP (2 relays), or 
Waveshare Relay (8 relays, Modbus RTU). 

Command Visible only for Generic devices. Enter the hex bytes to send (e.g. FF 01 
02). Hidden for Symcod and Waveshare types because the command 
is auto-built per event. 

ID Unique short identifier (max 16 characters). 

Description Human-readable label (max 50 characters). 

Mode Client (most common) or Host. 

IP Address Device IP for Client mode. Hidden in Host mode. 

Port TCP port. Default 1024 for Symcod, varies for others. 

Test (in the Device dialog) 

A Test section at the bottom of the Device dialog lets you fire the device immediately without saving the 
configuration: 

• Relay # - the relay number to activate (1 for single-relay devices). 

• Duration (s) - how long to keep the relay closed. 

• Test now button - sends the command using the values currently entered in the dialog above. 

When you click Test now, a progress bar fills over a maximum of 3 seconds. The result is shown next to 
the bar: 

• Green check - the device responded successfully. 

• Red cross - the device did not respond (timeout) or returned an error. Check the Activity log 
page for details. 

NOTE: The 3-second timeout applies to TCP connect. A non-responding device never freezes the 
application - other schedules and devices continue working normally. 

Editing and deleting devices 

WARNING: When you delete a device, events that reference it remain in the schedule but will fail at 
runtime (the activity log will report "device not found"). The application warns you with a count of 
affected events before deletion. 
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6. Activity log page 

The Activity log page (third entry in the sidebar) shows a real-time chronological list of everything the 
application does: bells fired, network successes and failures, configuration changes, license events, etc. 

 

Figure 7 - Activity log page. 

Layout 

The page is a single full-screen log view. At the top right are three buttons: 

Field Description 

Copy Copies the entire log to the clipboard so you can paste it into an email, 
ticket, or text file. 

Save Saves the log to a .txt file. A standard "Save as" dialog opens with a 
suggested filename that includes a timestamp (e.g. 
BellRingingManager_log_2026-05-28_16-30-15.txt). The file is 
encoded as UTF-8 with a BOM so accented characters appear correctly 
in Notepad. 

Clear Clears the log on screen. The file (if you saved one) is unaffected. 

Log entry format 
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Each entry starts with a [HH:MM:SS] timestamp followed by a free-text description. Example bell-fire 
entry: 

[16:02:18] Bell ring sent - Device #0001, Type: Waveshare Relay (8 relays, Modbus RTU), Desc: 
First floor, Mode: Client, IP: 192.168.0.29, Port: 502 

NOTE: The log is kept in memory only. To preserve it across restarts, click Save and store the .txt 
somewhere safe. The log is shared between the GUI and the Windows Service - when both run, the 
GUI receives a copy of every event the service logs. 
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7. Licenses page 

Bell Ringing Manager requires a license to operate. Each license is tied to a specific PC via its hardware 
identifier (PC ID). 

 

Figure 8 - Licenses page with an active license. 

Status banner 

The colored banner at the top of the page summarizes the current license state. This is the SAME text 
that appears in the menu-bar "License:" indicator at the top right of every page (only the prefix differs): 

Field Description 

Active A valid license is active. The banner shows the expiry date and number 
of remaining days. 

Expires soon (warning) License expires within 30 days. Plan to renew. 

Trial mode No license active - the application runs for a 15-minute trial period 
with a live countdown. 

Expired / blocked No commands will be sent. Activate a new license code to resume 
operation. 

This PC's identifier 
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The PC ID is a unique 16-character code identifying this computer. It is required to generate a license 
code for this machine. 

• Click the Copy button on the right to copy the PC ID to the clipboard. 

• Send the PC ID to your vendor; they will return a license code that matches. 

Activating a license 

Paste your license code (24 characters, formatted XXXX-XXXX-XXXX-XXXX-XXXX-XXXX) into the input field 
and click Activate. If the code is valid for this PC, it appears in the table below and the banner turns 
green. 

Valid licenses table 

Lists all valid licenses currently stored on this PC (active and future). Columns are: 

Field Description 

License code The 24-character code as entered. 

PC ID The PC identifier the license is bound to. Should match this PC's 
identifier. 

Start date First day the license is valid. 

End date Last day the license is valid. 

State Active, Future, Expired or Other PC. 

Backup 

Click Save backup now... to create a ZIP archive containing your full configuration and license files. The 
archive is saved to a location you choose. Keep a copy in a safe place (USB key, network share, cloud 
drive). 

NOTE: The backup includes config.json, all license records and the activity log file (if you previously 
saved one). Restoring is as simple as extracting the ZIP into %PROGRAMDATA%\BillProduction\Bell 
Ringing Manager. 
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8. Windows Service 

To ring bells reliably 24/7 - even when no user is logged in - you can install Bell Ringing Manager as a 
Windows service. The service runs in the background, reads the same configuration file, and fires the 
schedule independently of the visible application window. 

 

Figure 9 - Service page with the service installed and running. 

Status panel 

Two indicators show the current state of the service: 

• Installed: Yes / No - whether the service is registered with Windows. 

• Running: Yes / No / - - whether the service is actively running. Shows "-" when the service is not 
installed. 

Action buttons 

Visible buttons change based on the current state: 

Field Description 

Install Not installed - registers the service with Windows. Requires UAC 
confirmation. 

Start Installed, stopped - launches the service. 
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Field Description 

Stop Installed, running - stops the service. Bells will no longer ring until you 
start it again or run the application. 

Uninstall Installed - unregisters the service. Stops it first if it is running. 

WARNING: Installing, starting or stopping the service requires administrator rights. Windows will 
display a UAC confirmation prompt when you click these buttons. 

Coordination between the application and the service 

When both the desktop application AND the service are running, the application detects this 
automatically and steps aside to let the service handle the scheduled bells. This avoids double-rings. 

When the service is stopped (or not installed), the application takes over and fires bells while its window 
is open. 

NOTE: The service uses the same config.json file that the application edits, so any changes you 
make in the application (events, devices, schedules) are picked up by the service within a few 
seconds. 

Installation via the installer 

The Inno Setup installer (BellRingingManagerSetup.exe) automatically installs and starts the Windows 
service during installation, configured for automatic start-up at every Windows boot - even before any 
user logs in. The service runs under the LocalSystem account. 
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9. The Tools menu 

Copy day... 

Open a dialog to copy events from one day to one or more other days, optionally across schedules. See 
Section 4 (Managing schedules) for details. 

Copy schedule to another... 

Open a dialog to copy ALL events from one schedule into another. The destination's description, status 
and dates are preserved - only the events are replaced. 

Import Symcod configuration... 

Import a legacy Symcod configuration (CLOCHE.1 through CLOCHE.7 files). The application: 

1. Auto-detects standard locations (C:\symcod.cfg\TCP_LIB_IP, billproduction folders) and asks for 
confirmation. 

2. Falls back to a folder picker if no standard location is found. 

3. Parses the files, summarizing how many events and new devices will be created. 

4. On confirmation, REPLACES all events of the currently selected schedule with the imported set 
and auto-creates devices for any new terminal IDs. 

Auto-created devices have these defaults: 

Field Description 

Type Symcod Bridge-IP 

Port 1024 

IP address 192.168.1.100 (placeholder - you must edit each one with the real IP) 

Mode Client 

Description "Terminal <ID> (Symcod import)" 

WARNING: The Symcod import replaces the currently selected schedule's events. If you want to 
keep the existing schedule, add a new schedule first and select it before running the import. 

Install service / Uninstall service 

Shortcuts to the same Install / Uninstall buttons available on the Service page. See Section 8. 
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10. The File menu 

Import schedule... 

Import events from a CSV or XLS file into the currently selected schedule. The application detects the 
format from the file extension. When opening the file, you are asked whether to: 

• Replace - drop existing events and load the imported ones. 

• Add - keep existing events and append the imported ones. 

• Cancel - abort the import. 

Export schedule... 

Export the events of the currently selected schedule to a CSV or XLS file. A small dialog first asks which 
format you want, then a standard save-file dialog asks for the location. 

NOTE: Export uses the currently displayed schedule only. To back up all schedules at once, use the 
Backup feature on the Licenses page instead. 

Exit 

Close the application. If the Windows Service is installed and running, bells continue to fire normally. 
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11. Language settings 

Bell Ringing Manager supports three interface languages: 

• English (default) 

• French / Français 

• Spanish / Español 

To change the language, open the Language menu in the menu bar and select your preferred language. 
The change is applied instantly to every visible element: menus, dialogs, table headers, status labels, 
banners, the next-bell countdown, the schedule and device dialogs, and the license indicator at the top 
right of the menu bar. 

NOTE: Your language choice is saved in the configuration file, so the application will reopen in the 
same language next time. 
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12. Troubleshooting 

A bell did not ring at its scheduled time 

Click the Activity log entry in the sidebar to see what happened. Common causes: 

• No valid license (LED next to "License:" in the menu bar is red or gray; banner on the Licenses 
page confirms). 

• The device IP is wrong or the device is offline (look for network error 10060 in the log). 

• The schedule's status is Inactive, or it is a Period schedule outside its date range. 

• The event's "enabled" flag was unset (rare; events are enabled by default). 

• The application is closed AND the service is not installed/running. 

"Network error 10060" 

This means the application tried to connect to a device but received no response within the 3-second 
timeout. Verify: 

• The device is powered on and connected to the network. 

• The device IP address is correct. 

• No firewall blocks the connection from this PC to the device. 

• You can ping the device from this PC: open a Command Prompt and type "ping 192.168.1.50" 
(substitute the actual IP). 

The application freezes briefly when sending a command 

This should not happen with current versions. If it does, open the Activity log page, click Save to capture 
the log, and send the file to your vendor. 

The service does not start 

Make sure you have administrator rights. Open the Services console (services.msc) and look for 
"BellRingingManagerSvc". If it is in the "Stopped" state with no clear error, check the Windows Event 
Viewer for application logs. 

I lost my license code 

Restore from your latest backup ZIP (the licenses are stored in the same configuration folder). If you 
have no backup, contact your vendor with your PC ID to request a replacement. 

Resetting to factory defaults 

Close the application, then delete: 

• %PROGRAMDATA%\BillProduction\Bell Ringing Manager\config.json (your devices and 
schedules) 

• %PROGRAMDATA%\BillProduction\Bell Ringing Manager\licenses.dat (your activated licenses) 
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On next startup, the application will recreate a fresh default schedule and prompt you to activate a 
license. 

WARNING: Resetting the configuration deletes all events, devices and schedules permanently. 
Always take a backup first. 
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13. Appendix 

File system locations 

Field Description 

Installation C:\Program Files\BillProduction\Bell Ringing Manager 

Configuration %PROGRAMDATA%\BillProduction\Bell Ringing Manager\config.json 

Licenses %PROGRAMDATA%\BillProduction\Bell Ringing Manager\licenses\ 

Service logs Windows Event Log under "Application" with source 
"BellRingingManagerSvc" 

Supported device types 

Field Description 

Generic Sends a raw hex command on TCP connect. Use for any device that 
accepts a fixed byte sequence. 

Symcod Bridge-IP 2-relay TCP/IP bridge. Default port 1024. Command auto-built from 
event's bell number and duration. 

Waveshare Relay 8-relay Modbus RTU over TCP. Command auto-built from event's bell 
number and duration. 

Keyboard shortcuts 

Field Description 

Ctrl+click Add or remove a row from the current selection (in any list). 

Shift+click Select a range of consecutive rows. 

Ctrl+A Select all rows in the current table. 

Double-click on row Open the row in Edit mode. 

Alt+F4 Close the application window. 

Contact and support 

For technical support, license renewal, or feature requests, contact: 

BillProduction 

Email: info@billproduction.com 

Website: https://bellalarm.billproduction.com/ 



Bell Ringing Manager - User Manual 

Page 27 / 27 

Version history 

Version 2026.05.28.17 - Multi-schedule support, JSON configuration, multi-row selection in tables, 
dedicated Activity log page, menu-bar license indicator with colored LED, compact Licenses page, 
parenthesized page subtitles, install via Inno Setup with automatic Windows service installation and 
auto-start at boot, full FR/EN/ES translation. 


